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Introduction 

What is the AquiStar® DO2 Sensor?

INW’s AquiStar® DO2 Smart Sensor is the next generation in trouble-free oxygen 
sensing design. Utilizing fl uorescence of a stable, immobilized ruthenium-based fi lm 
matrix, the sensor provides precision optical transmission and detection to measure 
oxygen concentration in the fl uid outside of the sensor. The DO2’s compatibility with 
INW’s WaveData® Wireless Data Collection technology makes it ideal for remote 
monitoring.

This industry standard digital RS485 interface device records over 250,000 records 
of dissolved oxygen, temperature, and power supply voltage data, operates with low 
power, and features easy-to-use software with powerful features.  

The unit is programmed using INW’s easy-to-use Aqua4Plus control software. Once 
programmed the unit will measure and collect data on a variety of time intervals.  

The internal microprocessor runs on 12 VDC and automatically turns the sensing unit 
on and off, as needed, to conserve power. 

 

Initial Inspection and Handling

Upon receipt of your smart sensor, inspect the shipping package for damage. If any 
damage is apparent, note the signs of damage on the appropriate shipping form. After 
opening the carton, look for concealed damage, such as a cut cable. If concealed 
damage is found, immediately fi le a claim with the carrier.

Do’s and Don’ts

Do handle the device with care.
Do store the device in a dry, inside area 

when not in use.
Do install the device so that the connector 

end is kept dry.
Don’t scratch the sensing window.

Don’t support the device with the connector. 
Use a strain relief device to take the 
tension off the connectors.

Don’t allow the device to free-fall down a 
well as impact damage can occur.

Don’t bang or drop the device on hard 
objects.
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Installation and Operation

Connecting the DO2 to a Computer

In its cabled confi guration, the DO2 cable is terminated with a weather-resistant 
connector.  Connect the weather-resistant connector to your computer’s USB port as 
shown below.  (For alternate connection options, see Appendix C.)

  Connect the DO2 to your PC using a USB to RS485 adapter. 
  (See Appendix C for alternate connection options.)

Installing the Aqua4Plus Software

The AquiStar® DO2 sensor comes with the Aqua4Plus host software that is installed 
on your PC or laptop. Use this software to program the datalogger, to retrieve data 
from the logger, to view collected data, and to export data to external fi les for use with 
spreadsheets or databases. 

Refer to the Aqua4Plus software manual for details on installing and using Aqua4Plus. 

Using the Sensor Without Aqua4Plus

Most users will use the sensor with INW’s Aqua4Plus software. However, this sensor is 
quite versatile, allowing you to do the following:

• Read via the Modbus® protocol using your own software.
• Read via SDI-12 protocol.
• Display readings on a panel meter.

If you want to use one of these methods, see Appendix D or contact INW for further 
details.

PC or Laptop
Computer

USB Port

USB to RS485
Adapter

DO2Cableless 
Confi guration

Screw-

DO2

cap
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Installing the Sensor

Lower the sensor to the desired depth. Fasten the cable to the well head using tie wraps 
or a weather proof strain-relief system.  Take a measurement to insure the sensor is not 
installed below its maximum range.   

Be sure the supplied cap is securely placed on the weather-resistant connector at the 
top of the cable. Do not install such that the connector might become submerged with 
changing weather conditions. The connector can withstand incidental splashing but is 
not designed to be submerged.

Collecting Data

Following is a brief overview on using Aqua4Plus to collect data. Please refer to the 
Aqua4Plus Instruction Manual for further details on confi guring and using Aqua4Plus.

Real Time Monitor 

Click Single to get a single reading.

Click Start to get a reading once a second. 

The unit will power up, run the wiper once, and then start taking readings.

Click Stop to stop the reading.

Note: These are snapshot readings and are not recorded on the sensor.

 

  The Real Time Monitor gives a snapshot of the 
  current readings on the sensor. (Your view may 
  differ slighty, depending on confi guration.)
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Setting up a Data Recording Session

Click the  tool button. A Session Profi le Window will open. Refer to the Aqua4Plus 
Instruction Manual for details in describing your session profi le. Click the Start button 
to save the session to the sensor and begin recording. 

Using the Session Profi le Window, describe the test 
steps for your particular test.

Retrieving Data from the Sensor/Datalogger

• Click on the session you want to upload.
• Click the   tool button.
• Select a fi le location.
• Click Save.
• Click Start.

Select the data session 
you are ready to upload.



7
Viewing Data

• Click the   tool button to view data as a table.
• Click the   tool button to view data as a graph.
• Navigate to the desired fi le, then click the Open button. (If the File Open box does 

not appear, click the File Menu, then select Open.)

 The File Display Window displays your data  
 in a tabular format.

 The Graph Window displays your data on an XY 
 coordinate graph.
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Exporting Data to .csv or .xls Files

• Using the File Display window, open the fi le you want to export.
• Click on the   tool button.
• Select a fi le location and enter a name for the fi le.
• Select a fi le type. 
• Click Save. 

A Word About  Units

Readings from the sensor can be displayed in various units, such as degrees Celsius or 
degrees Fahrenheit for temperature. Select the units you want from the 
Options | Units menu. 

Maintenance

Sensor:  There are no user-serviceable parts. If problems develop with sensor stability 
or accuracey, contact INW. If the unit has been exposed to hazardous materials, do not 
return without notifi cation and authorization.

Cable:  Cable can be damaged by abrasion, sharp objects, twisting, crimping, crushing, 
or pulling.   Take care during installation and use to avoid cable damage.   If a section 
of cable is damaged, it is recommended that you send your sensor back to replace the 
cable harness assembly.  

End Connections:  The contact areas (pins & sockets) of the connectors will wear out 
with extensive use.   If your application requires repeated connections other types of 
connectors can be provided.   The connectors used by INW are not submersible, but are 
designed to be splash-resistant.

DO Window Cleaning:  During deployment the sensing window on the DO2 may 
collect debris or growth. Heavy debris/growth can affect the accuracy of the DO 
readings over time. Periodically check the window and clean if necessary. Note: the 
DO window is very sensitive and prone to scratching, DO NOT use abrasive cleaners. 
We recommend using a wash bottle and DI water to remove the loose debris. If there 
is a stubborn growth over the window you may clean it with a very soft cloth or Q-tip 
and a very light touch. Take care not to exert too much pressure or scratch the window 
surface during cleaning. A mild detergent may be used if necessary, such as Alconox. 
The main body of the unit may be cleaned with a mild detergent as well.



9
Trouble Shooting

Erratic Readings

Erratic readings can be caused by a poor connection, damaged cable, moisture in the 
unit, or a damaged transmitter.  In most cases, erratic readings are due to moisture 
getting into the system.   The fi rst thing to check is the connection.   Look for moisture 
between contacts or a loose or broken wire.  Next, check the cable for cracking or 
fraying.  If the connections and cable appear OK, but the readings are still erratic, the 
transmitter may be damaged.  Contact INW for evaluation and repair. Erratic and 
erroneous readings can also occur due to improper grounding. See Grounding Issues, 
below.

Grounding Issues

It is commonly known that when using electronic equipment, both personnel and 
equipment need to be protected from high power spikes that may be caused by 
lightning, power line surges, or faulty equipment. Without a proper grounding system, 
a power spike will fi nd the path of least resistance to earth ground – whether that path 
is through sensitive electronic equipment or the person operating the equipment. In 
order to ensure safety and prevent equipment damage, a grounding system must be 
used to provide a low resistance path to ground. 

When using several pieces of interconnected equipment, each of which may have its 
own ground, problems with noise, signal interference, and erroneous readings may be 
noted. This is caused by a condition known as a Ground Loop. Because of natural 
resistance in the earth between the grounding points, current can fl ow between the 
points, creating an unexpected voltage difference and resulting erroneous readings. 

The single most important step in minimizing a ground loop is to tie all equipment 
(sensors, dataloggers, external power sources and any other associated equipment) to a 
single common grounding point.  INW recommends connecting the shield to ground 
at the connector end.
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Appendix A: Technical Specifi cations

The AquiStar® DO2 Smart Sensor is a microprocessor based digital intelligent sensor 
designed to measure dissolved oxygen, utilizing fl uorescence of a stable, immobilized 
ruthenium-based fi lm matrix.

GENERAL
Probe Diameter 1.66” (4.22 cm)
Tube Material Acetal & 316 stainless steel or titanium
Probe Material Epoxy, polyurethane, and PVC
Wire Seal Material Fluoropolymer and PTFE
Submersible Cable Polyurethane, polyethylene, 
 or FEP available
Terminating Connector Available
Communication RS485 Modbus® RTU
Direct Modbus Read Output 32-bit IEEE fl oating point
Internal Math 32-bit fl oating point
Operating Temp. Range 0° C to 55° C
Storage Temp. Range -40° C to 80° C

LOGGING 
Memory 260,000+ records
Log Types Variable, user-defi ned, 
 logarithmic, profi led 
Programmable Baud Rate 9600, 19200, 38400
Logging Rate 8x/sec maximum
Software Complimentary Aqua4Plus or Aqua4Push
Networking 32 available addresses per junction 
 w/batching capabilities (up to 255)
SENSOR
File Formats .xls / .csv / .a4d
Measuring Range 0 - 25 ppm
Accuracy 1% of reading or 0.02 ppm — 
 whichever is greater
Sensitivity / Resolution 0.01 ppm below 4.00,
 0.1 ppm above 4.0
Stability 0.01 ppm
Repeatability 0.01 ppm
Sensor Drift Less than 1% per year
Temperature Range 0° C to 55° C
Response Time 95% in less than 60 seconds
Maximum Pressure 100 PSI
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For Modbus® — 
with 5-pin connector

For SDI-12 — 
with 5-pin connector

For SDI-12 — 
without connector

White
Purple
Yellow
Brown
Blue
Shield

12 VDC+ (Vaux)
Modbus D-
Modbus D+
SDI-12 (Not used)
Ground

1
2
3
4
5
5-Pin 
Connector

White
Purple
Yellow
Brown
Blue
Shield

12 VDC+ (Vaux)
Modbus D- (Not used)
Modbus D+ (Not used)
SDI-12 Signal
12 VDC – (Gnd)

1
2
3
4
5
5-Pin 
Connector

White
Purple
Yellow
Brown
Blue
Shield (may be green)

12 VDC+ (Vaux)
Modbus D- (Not used)
Modbus D+ (Not used)
SDI-12 Signal
12 VDC – (Gnd)
Earth ground

POWER
External Power Pack Required (9-15VDC)
INW Power Pack described below. 
Other power options available. 
Contact INW for details.

    INW Power Pack
Enclosure Material Polycarbonate (1P67)
Enclosure Dimentions 5.5” x 3.1” x 2.6” 
 (14 x 7.9 x 6.6 cm) 
 (excluding connectors)
Power Supply 12VDC (8 AA cells)
Connectors 1 communication port
 1-3 sensor ports

WIRING
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Appendix B: Field Calibration  
Calibration can only be done when there are no sessions stored on the sensor. If there 
are any sessions stored on the sensor, upload any data you want and then erase the 
session before continuing.

When using fi rmware 2.3 or later:
-- Must use Aqua4Plus 1.9.302 or higher (1.9.4 or higher recommended). --

• In Aqua4Plus, select Confi gure=> Advanced => DO2 Probe Calibration.
• Place the DO2 probe in reference solution and allow temperature to fully 
 stabilize.
• Using alternate method, determine DO saturation in ppm.
• Enter this value in the text box on the form.
• Click the Calibrate button - this will trigger the DO probe’s internal calibration. 

This will take a few seconds.
• Once you receive a message that it has calibrated, you can remove it from the 

reference solution.

When using fi rmware 2.2 or earlier:
This is older fi rmware and fi eld calibration has been much improved with fi rmware 2.3 
and higher. Contact your INW representative to inquire about updating your fi rmware.

 
One-Point Calibration:
-- Computing Calibration Value --

• Place sensor in sample to be measured. Allow time for sensor to stabilize.
• If sample is of known specifi c value, enter this value in the Ref box for the fi rst 

point 
• Alternately, using an accurate alternate measuring device, take a measurement. 

Enter this value in the Ref box for the fi rst point.
• Click fi rst Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the 

pop-up box.
 
-- Applying Calibration Value --

• Click the Apply button to apply calibration value. 
• The computed b value will be transferred to the calibration fi eld. 
• Click OK to save the value to the sensor.

 



13
Two-Point Calibration:
-- First Calibration Point --

• Place sensor in sample to be measured. Allow time for sensor to stabilize.
• If sample is of known specifi c value, enter this value in the Ref box for the fi rst 

point 
• Alternately, using an accurate alternate measuring device, take a measurement. 

Enter this value in the Ref box for the fi rst point.
• Click fi rst Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the 

pop-up box.
 
-- Second Calibration Point --

• Place sensor in sample with a different value. Allow time for sensor to stabilize.
• If sample is of known specifi c value, enter this value in the Ref box for the 

second point 
• Alternately, using an accurate alternate measuring device, take a measurement. 

Enter this value in the Ref box for the second point.
• Click second Measure button.
• When readings have stabilized to your satisfaction, click the OK button in the 

pop-up box.
 
-- Applying Calibration Values --

• Click the Apply button to apply calibration values. 
• The computed m and b values will be transferred to the calibration fi elds. 
• Click OK to save the values to the sensor.
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Appendix C: Alternate Connection Options

Connecting via RS232 Serial Port

In its cabled confi guration, the DO2 cable is terminated with a weather-resistant 
connector.  Connect the weather-resistant connector to 
your computer’s serial port as shown below.

Connect the DO2 to your computer using an RS485/RS232 adapter and 
an interface cable.

Connecting with a USB/Serial Adapter

USB-to-Serial cables are readily available from many electronics and computer stores, 
as well as numerous sites on the Internet. INW has tested and recommends the Keyspan 
USA-19HS. It is available from INW as well as from many sites on the Internet. Install 
as follows:

• Plug into USB port.
• Install the drivers provided with the particular unit.
• Determine the port number to which the adapter is assigned.
Right-click on My Computer.
From the popup menu, select Manage to open the Computer Management 

window. 
On left panel, click on Device Manager.
On right panel, double-click on Ports.
A list of active COM ports will be displayed. Note the COM number 

assigned to the adapter you just installed. 
 For example: 
Close Manager.

• Connect to the sensor.
• On the Aqua4Plus software, select the COM port noted above. (If you do not 

see your new COM port in the dropdown box, open the Communications dialog 
box from the Options menu. Increase the Highest COM port number, up to a 
maximum of 15.)

PC or 
Laptop

Computer

RS485/RS232
Adapter

Interface Cable

Serial Port

DO2

Screw-

DO2

cap

Cableless 
Confi guration
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   Connect the DO2 to your computer using a 
   USB to Serial adapter and an interface cable.

Interface 
Cable

PC or Laptop
Computer

USB Port
USB-to-Serial 

Adapter

RS232/RS485
Adapter

DO2

Screw-

DO2

cap

Cableless 
Confi guration
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Appendix D: Reading the AquiStar® DO2 Sensor 
via Direct Read
While the DO2 comes with INW’s easy to use Aqua4Plus software, you can also use 
standard Modbus® RTU or SDI-12 equipment to easily take readings, so as to tie into 
your existing equipment or networks.

You may need to use Aqua4Plus to set the baud rate. (You do not need to set the baud 
rate for SDI-12).  

Reading Via Modbus®

Setting Baud Rate
Your sensor comes confi gured to communicate at 38,400 baud, with 8 data bits, one 
stop bit, and no parity. The sensor can also be set to 19,200 or 9600 baud, if needed for 
your application.

If needed, set your sensor to the desired baud rate as follows:
• Click on the Confi gure menu, and then select Advanced.
• From the fl yout menu, select Sensor Baud Rate. (You may be asked for a 

password. Enter admin.) 
• On the popup box, click the down-arrow and select the baud rate you need, and 

then click OK.

Once you have changed the baud rate on the sensor, you will not be able to talk to it 
with Aqua4Plus until you change the baud rate for Aqua4Plus, as follows:

• Click the Options menu, and then select Baud Rate.
• On the popup box, click the down-arrow, select the baud rate you need, and then 

click OK.

The current Aqua4Plus baud rate is displayed in the lower right corner of the main 
Aqua4Plus window.

Taking Measurements
Reading Registers
Read measurements using Modbus function 03 – Read Holding Registers.
Readings are located in two registers each, starting at address 62592. (AquiStar® 
register addressing is zero based, i.e., starts at zero. If your equipment uses one based 
addressing, you will need to add one to the register addresses.) 

Note:
The DO2 comes in both a box version and a tube version. The box version may 
include a barometric sensor, while the tube version does not. If your unit does not
have a barometric sensor, any values in the Pressure register should be ignored.
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        Register addresses for AquiStar® DO2 Sensor 
 Zero Based One Based
Temp (on board) 62592 62593
Pressure 62594 62595
Power 62596 62597
DO 62598 62599
Temp (on probe) 62600 62601

Data Format
The data is returned as 32-bit IEEE fl oating-point values, high word fi rst, also referred 
to as big-endian or fl oat inverse.

Power On Function
The AquiStar® DO2 Sensor requires a warm-up or stabilization time after application of 
power before accurate readings can be taken. 

The Power On functionality is controlled by writing a value to register 62720 (0xF500). 
This is how long the sensor stays on once a reading is requested. This value represents a 
quarter second and defaults to 30 (7.5 seconds) whenever the unit is power cycled. 

• Write Power On value of 30 (30/4 = 7.5 seconds)
• Power turns on
• Starts sampling about two times a second
• Wait 8 seconds 
• Request a reading
• Returns most recent reading
• Resets Power On to 30 (30/4 = 7.5 seconds) 
• Write Power On value of 0
• Turns power off
• Retains last reading 

This is the preferred method to ensure proper warmup/stabilization and to conserve 
power as much as possible. This, however, requires that your monitoring equipment 
have the ability to write to the sensor. 

If you are reading your device using a meter or other device that cannot write the Power 
On but simply takes readings on a specifi ed schedule, be sure to set the polling interval 
to less than 7 seconds. That way the sensor is always powered up and readings should 
be fresh and stable. Note that the fi rst reading when you turn on the sensor and meter 
will be old but will refresh within a second
 

For further information and detailed Modbus examples, see INW application note, 
“Modbus Direct Read on AquiStar Smart Sensors” available from our web site at 
http://www.inwusa.com/appnotes.htm.
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Reading Via SDI-12

Addressing
Default SDI-12 Address: 0

SDI-12 Command Nomenclature
<a> = Sensor address
{crc} = SDI-12 compatible 3-character CRC
<cr> = ASCII carriage return character
<lf> = ASCII line feed character
highlighted values indicate variable data

SDI-12 Commands
//*** Sensor Identifi cation
<a>I! <a>13  INWUSA  SMDO2.01ssssssssss<cr><lf> 
 // note: 2.01 will change to refl ect current 
 // fi rmware revision 
 // ssssssssss = device serial #

//*** Acknowledge Active, Address Query
<a>! <a><cr><lf>
?! <a><cr><lf>

//*** Change Address 
<a>A<b>! <b><cr><lf> // change address from <a> to <b>

Note:
The DO2 comes in both a box version and a tube version. The box version may include 
a barometric sensor, while the tube version does not. If your unit does not have a baro-
metric sensor, the second value returned from the SDI-12 command (M!, MC!, C!, or 
CC!) should be ignored.

//*** Request measurement
<a>M! <a>0045<cr><lf> // request all measurements
<a>D0! <a>+23.1374+14.9829+12.1616+3.9829<cr><lf> 
 // read: temperature (on board), 
 //          pressure
 //          power
 //          DO

<a>D1! <a>+19.1374<cr><lf> // read: temperature (on probe)
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//*** Request measurement with CRC
<a>MC! <a>0045<cr><lf> // request all measurements w/CRC
<a>D0! <a>+23.1374+14.9829+12.1616+3.9829{crc}<cr><lf> 
 // read: temperature (on board), 
 //          pressure
 //          power
 //          DO

<a>D0! <a>+19.1374{crc}<cr><lf> // read: temperature (on probe)
//*** Concurrent measurement
<a>C! <a>0045<cr><lf> // request all measurements
<a>D0! <a>+23.1374+14.9829+12.1616+3.9829<cr><lf> 
 // read: temperature (on board), 
 //          pressure
 //          power
 //          DO

<a>D0! <a>+19.1374<cr><lf> // read: temperature (on probe)

//*** Concurrent measurement with CRC
<a>CC! <a>0045<cr><lf> // request all measurements w/CRC
<a>D0! <a>+23.1374+14.9829+12.1616+3.9829{crc}<cr><lf> 
 // read: temperature (on board), 
 //          pressure
 //          power
 //          DO
<a>D0! <a>+19.1374{crc}<cr><lf> // read: temperature (on probe)

For further information and SDI-12 examples, see the INW application note, “DO2 Interface 
Specifi cation (SDI-12 and Modbus)” available from our web site at www.inwusa.com/technical-
library.
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Appendix E: Error Code Chart  
Any reading over 1000 indicates an error, as detailed in the chart below. To use this chart, 
look up the 1000+ reading from your sensor and note the Sensor Error code in the second 
column. Then note the Errors 0 – 5. See error descriptions after chart.
 

Errors
Aqua4Plus Reading Sensor Error Code 5 4 3 2 1 0
1001 01 √
1002 02 √
1003 03 √ √
1004 04 √
1005 05 √ √
1006 06 √ √
1007 07 √ √ √
1008 08 √
1009 09 √ √
1010 10 √ √
1011 11 √ √ √
1012 12 √ √
1013 13 √ √ √
1014 14 √ √ √
1015 15 √ √ √ √
1016 16 √
1017 17 √ √
1018 18 √ √
1019 19 √ √ √
1020 20 √ √
1021 21 √ √ √
1022 22 √ √ √
1023 23 √ √ √ √
1024 24 √ √
1025 25 √ √ √
1026 26 √ √ √
1027 27 √ √ √ √
1028 28 √ √ √
1029 29 √ √ √ √
1030 30 √ √ √ √
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Errors
Aqua4Plus Reading Sensor Error Code 5 4 3 2 1 0
1031 31 √ √ √ √ √
1032 32 √
1033 33 √ √
1034 34 √ √
1035 35 √ √ √
1036 36 √ √
1037 37 √ √ √
1038 38 √ √ √
1039 39 √ √ √ √
1040 40 √ √
1041 41 √ √ √
1042 42 √ √ √
1043 43 √ √ √ √
1044 44 √ √ √
1045 45 √ √ √ √
1046 46 √ √ √ √
1047 47 √ √ √ √ √
1048 48 √ √
1049 49 √ √ √
1050 50 √ √ √
1051 51 √ √ √ √
1052 52 √ √ √
1053 53 √ √ √ √
1054 54 √ √ √ √
1055 55 √ √ √ √ √
1056 56 √ √ √
1057 57 √ √ √ √
1058 58 √ √ √ √
1059 59 √ √ √ √ √
1060 60 √ √ √ √
1061 61 √ √ √ √ √
1062 62 √ √ √ √ √
1063 63 √ √ √ √ √ √
1128 Unable to communicate with sensor
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Reordering Information

For sales & service offi ces, please contact:

INW
www.inwusa.com

800-776-9355

ERROR DESCRIPTION

0 = Main photodiode saturated (circuite or sensor coating damage)

1 = Main photodiode negative (excessive electrical noise or damage)

2 = Reference photodiode saturated (circuite or sensor coating damage)

3 = Reference photodiode negative (excessive electrical noise or damage)

4 = Temperature error (thermistor is damaged)

5 = Temperature error (temperature is out of range)
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LIMITED WARRANTY/DISCLAIMER - AquiStar® DO2
DISSOLVED OXYGEN SENSOR

A.   Seller warrants that products manufactured by Seller when properly installed, used, 
and maintained, shall be free from defects in material and workmanship.   Seller’s 
obligation under this warranty shall be limited to replacing or repairing the part or parts 
or, at Seller’s option, the products which prove defective in material or workmanship 
within ONE (1) year from the date of delivery, provided that Buyer gives Seller prompt 
notice of any defect or failure and satisfactory proof thereof.   Any defective part or 
parts must be returned to Seller’s factory or to an authorized service center for inspec-
tion.   Buyer will prepay all freight charges to return any products to Seller’s factory, 
or any other repair facility designated by Seller.   Seller will deliver replacements for 
defective products to Buyer (ground freight prepaid) to the destination provided in the 
original order.   Products returned to Seller for which Seller provides replacement under 
this warranty shall become the property of Seller.

This limited warranty does not apply to lack of performance caused by abrasive materials, cor-
rosion due to aggressive fl uids, mishandling or misapplication.   Seller’s obligations under this 
warranty shall not apply to any product which (a) is normally consumed in operation, or (b) has a 
normal life inherently shorter than the warranty period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written approval by 
the Seller, all warranties are void.   Equipment and accessories not manufactured by the Seller are 
warranted only to the extent of and by the original manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, WHETH-
ER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY.   IMPLIED WARRANTIES 
OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.   SELLER’S WARRANTY 
OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS TO TITLE) ARE 
SOLELY AND EXCLUSIVELY AS STATED HEREIN.   IN NO CASE WILL SELLER BE 
LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN CONNECTION 
WITH REMOVAL AND REPLACEMENT OF THE SENSOR SYSTEM, LOSS OF PRODUC-
TION OR ANY OTHER LOSS INCURRED BECAUSE OF INTERRUPTION OF SERVICE.   
A NEW WARRANTY PERIOD SHALL NOT BE ESTABLISHED FOR REPAIRED OR 
REPLACED MATERIAL, PRODUCTS OR SUPPLIES.   SUCH ITEMS SHALL REMAIN 
UNDER WARRANTY ONLY FOR THE REMAINDER OF THE WARRANTY PERIOD ON 
THE ORIGINAL MATERIALS, PRODUCTS OR SUPPLIES.

B.   With respect to products purchased by consumers in the United States for personal use, the 
implied warranties including but not limited to the warranties of merchantability and fi tness for a 
particular purpose, are limited to twelve (12) months from the date of delivery.

Some states do not allow limitations on the duration of an implied warranty, so the above limita-
tion may not apply to you.   Similarly, some states do not allow the exclusion or limitation of 
consequential damages, so the above limitation or exclusion may not apply to you.   This limited 
warranty gives you specifi c legal rights; however, you may also have other rights which may vary 
from state to state.
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